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  What is Gold-Vision Connect? 
 
Gold-Vision Connect is an online contact management service that integrates with Gold-Vision CRM. 
Currently, Gold-Vision Connect allows you to send targeted direct marketing emails to your Gold-Vision 
Contacts and track responses. 
 

The Gold-Vision Connect Process 

 

 

  

http://www.gv-c.com/media_docs.aspx
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Accessing Gold-Vision Connect: 
Tools  Gold-Vision Connect 
 
 
 

 
 

 
 

You can also login to Gold-Vision Connect via: 
http://portal.gv-c.com Enter username and 
password 

 
 

 Gold-Vision Connect Home Page 

The Gold-Vision Connect home page shows: 
 

 News items  

 Recent Events – mailshots accessed, sent, uploaded, images uploaded or deleted etc. 

 Recent Mail shots – most recent mail shots which have been uploaded 
 
Click on the Recent Event or Mailshot to open the item. 
 

 
 
  

http://portal.gv-c.com/
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 Getting Started 

Navigation 

To navigate through the main system areas, please use the main menu at the top of the screen. To 
open a menu section, click on one of the title words from the menu. A sub menu will appear with 
related options. Click on one of the sub menu option to navigate to that section.  

 

Contacts 

 
This shows a list of all contacts uploaded to Gold-Vision Connect, all unsubscribed and Double Opt-In 
contacts. 

Mailshots 

 
Mailshots are Gold-Vision Campaigns that have been uploaded to Gold-Vision Connect to be sent as 
trackable emails.  Emails can be fully designed using the WYSIWYG editor including images, 
attachments and click-thru links.  Responses, click-thrus, bounce-backs, unsubscribes can all be 
tracked and reported on 

Media 

 
The Media Library is a repository for images and documents.  It allows you to upload and store media 
for use later in mailshots for example.  A range of image and document types can be uploaded to the 
library and are shared between you and your colleagues with similar access to Gold-Vision connect. 

Settings 

 
Under settings you can update your contact details, change your password, change program settings 
and view available credit. 
 
Reporting 
 
Top level reporting across all your Connect data. 
 
Help 

 
Access to Online help and Support 
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Designing your Template 

 What are Templates 

Templates allow you to create and edit the body of an email independently of a Mailshot. The main 
reasons for using a Mailshot template are that you can re-use the design between Mailshots and also 
work on a design before having uploaded a Gold-Vision Campaign to Gold-Vision Connect. Templates 
can be applied to a Mailshot under the design tab  

 Media Library 

 

The Media Library is a repository for images and documents.  It allows you to upload and store media 
for use later in Mailshots or forms for example.  A range of image and document types can be 
uploaded to the library and are shared between you and your colleagues with similar access to Gold-
Vision connect. 

When an image or document is uploaded to the Media Library it is stored live on the Gold-Vision 
Connect public web server under a unique link. You can add images to Mailshots and also create links 
to your documents or alternatively attach them to Mailshots. 

 Image Library 

The Image Library is a repository where you can upload images to Gold-Vision Connect for later use. 
Images of type bmp, jpg, gif and png can be uploaded. There is an enforced file size restriction on 
250kb per image. Uploaded images are shared between you and any colleagues with a Gold-Vision 
Connect login. 

JPG – High compression which means they are very good for larger images like photos because they 
take up less byte space.  They are not very good for smaller images with strong colour contrast (such 
as textual content) as the compression causes an undesirable, blur “fringing” effect. 
 
GIF – Maintains colours so very good for textual images.  Can have “transparent” regions.  Limited to 
256 colours, so poor for photos or images with high blended colours.  Good for Company logos. 
 
PNG – Similar to GIF but with more colours.  Down side is that the file size tends to be larger. 
 
BMP – Similar to PNG but tend to be even larger still.  Not recommended. 
 
NOTE: background images are not supported by most email readers.  Background colours are 
supported; however, heavy use of high contrast colours can be seen as a “spam” type email. 

Uploaded images can be added to mailshots or templates whilst using the HTML editor tool. 
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 The Image Library 

The Image Library is a location where you can upload and organise images for later-use in mailshot or other 
designs. To open the Image Library: 

1. Click Media from the main menu 
2. Click Images from the sub menu 

 

Uploading Images   

To upload new images follow the instructions below.  

1. Click the Upload Image button that is displayed towards the top of the screen 
2. A dialog will appear prompting you to select a file 
3. Click the Select Image button and select an image from your computer 
4. The image will automatically upload 

Please Note: There is a maximum image size restriction displayed on the upload dialog. You cannot upload 
images larger than this. We recommend that you resize your image to the approximate size you require 
before uploading to Connect. 

 

 

 

Searching for Images   

To search for an image use the standard search 
control at the top of the page. You can search by file 
name, size or date of upload.  

Once you have found the image you are looking for, 
click hover over the thumbnail and click 'Preview' to 
preview it.  
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Deleting Images   

To delete an image, click hover over the thumbnail 
and click Delete. You will be asked to confirm - click 
Delete to confirm. 

  

Organising Images in Folders  

Images can be organised into folders. Media (images and documents) can be moved into folders to help with 
organisation. The list of media folders is visible on both the document and image lists. 

The default folder option shows all images/documents from all folders and is useful for overall searching. 

Opening a Folder 

To open the contents of a media folder, click on its 
name from the list on the left of the screen. The list of 
media items to the right will refresh and the contents 
of the folder you clicked on will be shown.  

 

Adding New Folders 

To add new folders simply enter the name you wish 
to use in the box at the bottom of the folder list and 
click the 'Add' button. The image below illustrates 
this. 

 

Deleting Folders 

To delete a folder, click the delete/trash icon to the right of the folder name. You will be prompted to confirm - 
click Delete to confirm. The image below shows how to delete a folder.

 

Please Note: If you delete a folder, all the sub-media within that folder will also be deleted.  

Moving Items  

To move items between folders you must click the Move link that appears against the media item and then 
select a folder to move the item to. In the case of images the Move link appears when you hover over the 
preview whereas for documents the Move link appears in the list.  

The image below shows how to move a document.  
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 Document Library 

The Document Library is a repository where you can upload documents to Gold-Vision Connect for 
later use. Documents of type doc(x), xls(x), zip, ppt, pdf and txt can be uploaded. Uploaded 
documents are shared between you and any colleagues with a Gold-Vision Connect login. 

Uploaded documents can be added to Mailshots as attachments or links whilst using the HTML editor 
tool. 

To open the Document Library: 
1. Click Media from the main menu 
2. Click Documents from the sub menu 

 

Uploading Documents   

To upload new documents follow the instructions below.  

1. Click the Upload Document button that is displayed towards the top of the screen 
2. A dialog will appear prompting you to select a file 
3. Click the Select Document button and select a document from your computer 
4. The document will automatically upload 

Please Note: There is a maximum document size and also type (doc, pdf etc) restriction displayed on 
the upload dialog. You cannot upload images larger than this restriction or of other types.  

 

Searching for Documents   

To search for a document use the standard search control at the top of the page. You can search by 
file name, size or date of upload. Once you have found the document you are looking for, click on the 
name in the list to open/download it.  

Deleting Documents   

To delete a document, click the 'delete' or 'trash' icon to the right of the list item as shown in the 
image below. 

 

You will be asked to confirm the delete - click Delete to confirm. Organising Documents in Folders  

Documents can be organised into folders. To learn more about media folders, see Image Library 

 

http://help.gv-c.com/Searching.htm
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Templates 
 

 Creating a Template 

Creating a Template  

Templates can be created in several ways – using the design tool, copying another template, copying a 
mailshot or they can created using an html package and uploaded into Gold-Vision Connect. 

 

1. Click Mailshots > Templates from the main menu 
2. Click the New button 
3. You will be navigated to an empty editor page 
4. Edit your template design and click the 'Save' icon to save your design 

 

5. Alternatively click the link to copy another design. Select from the options and search for a design to 
apply. 

 
 

 Uploading a Template 

Mailshot templates can be uploaded in the form of a zip file containing html and images. This will allow 
you to quickly apply templates that you or an external agency has designed using an html package 
such as DreamWeaver.  

One-Click Template Upload You can quickly upload an html page and multiple images in one step. 
Simply zip the files together into a single file and upload it using the template upload page.  

1. Click Mailshots > Templates from the mail menu 
2. You will be navigated to a list of templates 
3. Click the Upload Template button. 
4. A dialog will open prompting you to select your zip file 

5. Select your zip file from your computer and the upload will process automatically 
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The html page will be turned into a mailshot template and any images automatically will be added 
to the media library 

Please note the following restrictions  

 Include all style in the HTML file 

 Any images should be relatively referenced or hosted online 

 Do not use external CSS files 

 Try to avoid background images 

 

 
 Viewing Templates 

Templates can be viewed from Mailshots > Templates 

 

This will show a list of all templates. Folders can be created to enable you to organise your templates in a 
similar ways to images and documents. 

 
 Editing A Template 

Editing a Template  

1. Click Mailshots > Templates from the mail menu 
2. You will be navigated to a list of templates 
3. Click on the name of the template in the list to open it for editing. 
4. You will be navigated to the template designer 
5. Click the Save button to save your changes 

The template designer uses the same editor as the mailshot designer. Learn how to insert images or 
personalised tags. To learn more about the editor in general, see Editing Your Mailshot or Template. 

 
 
  

http://help.gv-c.com/MailshotImages.htm
http://help.gv-c.com/MailshotTags.htm
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 Editing Your Mailshot or Template using the HTML Editor 

The HTML editor included in Gold-Vision Connect offers WYSIWYG design of HTML content. It is 
comprehensive in its functionality whilst relatively simple to use.  

Text, images and visual content can be inserted, drag-and-dropped, copy-and-pasted, formatted and 
styled all using the in-built toolbar controls.  

Most common Windows keyboard shortcuts also work (ctrl+c, ctrl+v, ctrl+x, ctrl+z etc). 

 

 The Editor at a Glance 

The editor is split into three main areas. 

1. The toolbar is situated at the top of the screen and contains most of the controls. This can be 
used to control the format and style of your document as well as insert images and links. For 
a list of toolbar controls, see below  

2. In the centre of the screen is a large window containing the page content. This is where you 
can paste, type or insert the actual content of the document. Use the mouse or cursor keys to 
position the cursor and start typing. Alternatively highlight some text and use the toolbar 
controls to change the style or format.  

3. At the bottom of the screen is a smaller toolbar where you can switch between Design and 
HTML views of the document and also navigate and edit the Tag Tree.  

 

 
 

 

 Entering Text 

Text can be entered directly into the editor. Simply position the cursor where you would like to enter 
some text and start typing.  

Text can also be copied and pasted from other text sources such as Microsoft Word, Notepad or 
similar. When text is copied from a source like Word, the editor attempts to maintain all style (bold, 
colour etc) already applied to the text when you copied it.  
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 Formatting Text 

Choosing a Font 

Fonts and font size can be modified by using the appropriate dropdowns from the toolbar.  

Simply position the cursor into the text you would like to change or highlight some text and select a 
new font or size. In the example below, we change some text to Verdana Size 4.   

1. Position the cursor inside 
some text or highlight it  

2. From the Font dropdown 
select Verdana  

3. From the Size dropdown 
select Size 4  

 

 

Font Style and Colour 

Format and style changes can be made using the toolbar controls at the top of the screen. The 
typical way to do this is to move the cursor to the text location or highlight some text and then use 
one of the toolbar controls to modify the style. In the example below, we look at making some text 
bold and red.  

1. Move the cursor to the 
location you would like to 
change the format for or 
highlight some text  

2. Click the Bold toolbar 

button ( ) to make the 
text bold  

3. Next click the arrow next 
to the Font Color control 

( ) and select Red  

 

 

Text Justification 

Text can be justified left, right, centre or justified. This is performed by selecting a paragraph of text 
and choosing one of the justification options. In the example below we look at making a paragraph of 
text aligned to the centre 

1. Click or move the cursor 
into roughly the middle on 
a paragraph or line of text  

2. From the toolbar choose 
the centre justification 

option ( )  
3. The text will align to the 

centre of its containing 
element  
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 Inserting Images 

Images can be uploaded to Gold-Vision Connect via the Image Library and inserted using the HTML 
editor. To insert an image, please follow the instructions below.  See Image Library for more 
information about image types. 

 

1. Click the Insert Image button ( ) from the toolbar.  
2. An Add Image window will open  
3. Select an Image from the list, or select a folder, either Insert or Preview the image. To upload 

a new image, click the Upload New button.  
4. The image will be inserted into the editor window  

 

 

Moving and Resizing Images 

 

Once the image has been inserted it can 
be moved by using drag-and-drop or 
resized by  

 

 
 
  



 TUTORIAL:     Gold-Vision Connect 3.6 
 

page 14 of 49 

 Inserting Tables 

Select Insert Table from the Editor toolbar 

 

 

Using the Wizard select the number of rows and 
columns required 

 

 

 

Once the table has been inserted the cells, rows 
or table can be formatted 

Click on the table to activate the table tag tree at 
the bottom of the screen. 

 

 

Select <table> to select the whole table 

 

 

 

 

Select <tr> to select the whole row 
 

Select <td> to select the cell 

 

 

 

 

To change the Font Colour or Highlight of the 
table/row or cell colour chose from the selection 
or chose more colours and select from the 
colour palette. 
 
 
Select Style to amend the font, colour, highlight 
and alignment. 
 
Select Properties to change row/column size, 
background colour, borders as well as format 
the text. 
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Adding/Deleting Rows or Columns  
 
Click on the table, select <table> at the bottom 
of the screen and select properties. 
 
To add rows or columns click the - +  
 
Merging Cells 
 
To merge/unmerge cells to the right click in the 
cell then select ColSpan + or - 
 
To merge/unmerge cells down click in the cell 
then select RowsSpan + or - 
 
You will see the effect of the changes on the 
table as you make the changes 
 
You can also select from Table Layout 
dropdown menu  

 

Editing the Table 
 
Changing the size of the table 
 
From the Table Wizard select Table 
 
Amend the Width, Height, Alignment of the table 
 
Colour 
 
Click on Background/Border colour to select 
your background or border colour 
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 Adding Links 

One of the most power features of Gold-Vision Connects Mailshots is the ability to track which 
recipients have clicked on which links within your mailshot. In order for this to be possible, special 
action-links must be added to the mailshot at design time. Please note that you should have the 
mailshot open for editing and be familiar with the editor. 

Adding an Action-Link 

1. Click-and-select to highlight some text or an image you would like to link 

2. Click the Link toolbar button ( ) 
3. A new window will open prompting for a URL 
4. Enter the URL you would like to link to 
5. Click OK 

 

Removing a Link 

To remove a link, click the cursor into the middle of the linked text or click once on the linked image 

and then click the un-link toolbar button ( ). 

 
 Adding Custom Links 

Gold-Vision Connect supports several types of custom link that allow you to provide specific 
functionality to the end recipients. 

To select a custom link you must first open the mailshot in the Designer and then click the 'Custom 
Links' drop down box from the toolbar. 

 

1. Click-To-Forward - allows end recipients to 
forward your email whilst you track the 
event. 

2. Click-To-Read - end recipients can click on 
to read your email in a browser. 

3. Opt-In - allows end recipients to 'Double-Opt-
In' to your mail shots. 

4. Preferences - Allow end recipients to 
manage their mail preferences as defined by 
you under your Mail Campaign Type 
Settings. (more detail to follow) 

5. Unsubscribe - custom 'unsubscribe' link. 

Contact Update - Allow your recipients to update 
their contact details as defined by you under your 
Contact Update Settings. See Administrator 
Settings for more information. 
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Adding Anchors  

Page anchors allow visitors to jump to a specific place in the current webpage or to jump to a 
specific place on another web page. 
You usually use page anchors if you want a graphic or text to link half way down another page. That 
way your visitor doesn't have read all through the page to get to the bit their interested in. 

To create a link that points to another place on the same webpage, you need to create two anchors:  

 a named anchor in the spot that you are going to jump to  

 an anchor in the spot that you are going to jump from  
 

Anchor links are links to locations elsewhere within the design. They are useful for jumping from 
summary information at the start of your mail to detailed information further down.  

 

Step 1 - Creating an Anchor 
(Destination) 

1. Open your mailshot for 
design 

2. Highlight a word or text that 
you would like to make the 
designation anchor 

3. Click the anchor icon from 

the tool bar ( ) 
4. Enter a name (do not use 

spaces) 
5. Click Insert 

 

 

Step 2 - Linking to the Anchor  

1. Highlight a word or text that you would like to link from 

2. Click the link icon from the menu ( ) 
3. A link dialog will appear 
4. Click the 'Select a named anchor in the current page' box 
5. Select your anchor from the list 
6. Click OK 

 

 
  
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 Template Tags 

Template tags allow you to personalise your mailshot body to include sender and recipient names and 
contact details. Please note that you should have the mailshot open for editing and be familiar with the 
editor. 

Inserting a Template Tag 

1. Click the cursor where you would like to insert the tag 
2. Click the Template Tags drop control from the toolbar 
3. Click on a Tag Name 
4. The tag will be inserted at the cursor location 

In the example below, the text "Dear" has been entered followed by a space. Next, the "Recipient - 
First Name" tag has been selected. This will be inserted directly after the space.  

 

How Do Template Tags Work? 
Template tags are stored as text in the email body and are replaced when the mailshot is previewed 
or sent with the corresponding data. For example the tag 
 
   [DATA:FIRST_NAME=Sir/Madam]  
 
might be replaced with the name  
 
   Andrew 
 
Hence the text "Dear [DATA:FIRST_NAME]" might become "Dear Andrew".  

If there is no data in the first name field, this will be replaced with Sir/Madam 

Sir/madam can be amended as required e.g Customer or Member 

When you click the Preview tab under a mailshot, you will be navigated to the mailshot preview page. 
Any template tags will be replaced with data and any tags that did not contain data will be listed under 
a warning message.  

 Saving or Discarding Changes 

Saving Changes 
It is important to save your changes before navigating away from the editor page. To do this click the 

Save button ( ) from the toolbar.  
 
Discarding Changes 

If you are not happy with your changes and would like to discard them, simply click the Discard 

Changes button ( ) and confirm.  
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Design Tips 

Can I use my own designer for example DreamWeaver? 
 
Yes, you can design emails using DreamWeaver or a similar tool and then upload them as a template 
email to Gold-Vision Connect.  
 

1. Create a single HTML page in DreamWeaver 
2. Ensure any images are stored locally to the HTML page and reference using an <img>  tag 

(not CSS) 
3. Do not use any external CSS stylesheets, include the CSS in the <head> tag 
4. ZIP the HTML document and all images into a single ZIP file 
5. From the Mailshots -> Templates page select the “Upload a Template” open 
6. Select your ZIP file and click “Upload” 

 
Can I use Word or MS Office to design Emails? 

Avoid pasting content directly from MS Word into the designer.  Doing this causes huge volumes of 
extra data to be added.  Instead, please try pasting the text into Notepad and then re-copy it and past it 
into the designer.  By pasting it into Notepad and then re-copying it, you remove any Word font or 
formatting.  

Text 

It is important to include at least some textual content in paragraph form because makes the email 
more legitimate.  Emails containing just images with no textual content at all often become blocked or 
filtered. Images containing text do not count. 

Enter the content first before applying any style.  Type / paste in all the content in “plain text” before 
attempting to change any fonts or styles.  By approaching the design in this order you will reduce the 
number of times you need to apply font or style to a given section and this in turn will avoid the 
problems that occurred with this particular mail shot. 

Avoiding Spam 

If you carry out email marketing campaigns and keep getting emails blocked before they reach your 
customers, then the chances are you're using too many words that look like spam. How does this 
work? Well every occurrence that is suspicious attracts points, and a high overall score for your mail 
means it'll get blocked. Scores vary depending on the software used, or how it is configured for the 
client, but rest assured, you'll also look like a spammer for telling everyone it's FREE! or that they can 
SIGN UP NOW!, so consider your wording carefully. 

Subject Line 

Consider the audience and think about the ‘what’s in it for me?’ principle. Don’t promise anything that 
the body of the email doesn’t deliver 

When to send 

If you are sending regular newsletters send them at the same time of day, recipients will then come to 
expect your newsletter 

Further information: 

Direct Marketing Association Email Marketing Council, Best Practice Guidelines June 2007 

http://www.dma.org.uk/_attachments/Resources/230_S4.pdf 
 

 

http://www.gold-vision.com/
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 What Are Mailshots 

Mailshots are Gold-Vision Campaigns that have been uploaded to Gold-Vision Connect to be sent as 
trackable emails. Emails can be fully designed using the HTML editor or a software design package 
such as DreamWeaver, including images, attachments and click-thru links. Responses, click-thrus, 
bounce-backs, unsubscribes can all be tracked and reported on and synchronised back to Gold-Vision. 

Please see the Gold-Vision Campaigns Tutorial for instructions on creating a Gold-Vision 
Campaign. 

Select a Type from the dropdown and select Email as the Medium. 

 

 

Uploading a Campaign to Gold-Vision Connect 

Once a Campaign has been created in Gold-
Vision, it can be uploaded to Gold-Vision Connect 
as a new mailshot. To "Run" a Campaign in this 
way, select  

Run > Export to Gold-Vision Connect from the 
Campaign menu in Gold-Vision. 

 
 

  

Click Yes 

 

 

You will receive an email confirming the upload of the Campaign to Gold Vision Connect 

Once completed, a Mailshot within same name will appear on your Home Page – Recent Mailshots 
(see image below) and  under your My Mailshots list in Gold-Vision Connect 
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 Applying a template to a Mailshot 

When you upload a Gold-Vision 
Campaign to Gold-Vision Connect, 
a new Mailshot will be created with 
the same name as the source 
Campaign. You will be able to see 
the new Mailshot under the My 
Mailshots list from Gold-Vision 
Connect or Recent Mailshots on the 
Homepage. 

 

 

 
When you first select the mailshot, 
you will be asked if you would like to 
apply a template to the design. If so, 
click Select Template and chose 
from your list of user templates, 
mailshots or stock templates. 

 

 

 

 

You can also copy a mailshot or use a stock template 

Once a Template has been selected you will be asked if you want to overwrite the design with this 
Template. Click OK.  

From Addresses   

From the main design section you must specify one or more 'From' addresses. These are the 
addresses that your mail shot will be sent on behalf of and also what the end recipient will see.  

To edit the 'From' addresses click the 'From' label as shown in the image below.  

 

A dialog box will load as shown in the image below. This will allow you to add and remove 'From' 
addresses from your mail shot.  

 
Please Note: It is possible to add multiple 'From' addresses to a single mail shot. When doing this a 
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random 'From' address will be used per recipient when the mail shot is sent. Using this functionality 
can improve deliverability, especially if you mail to large numbers of Hotmail, Live, Yahoo, Gmail or 
similar addresses.  

 

To add a new 'From' address enter the pre-@ and name you wish to use and then click the Add 
button. Click the small delete/trash icon to remove addresses and finally click Save when you are 
complete.  

Subjects   

From the main design section you must specify one or more Subjects. These are the subjects that 
will be displayed to the end recipient when your mail shot is sent.  

To edit the Subjects click the Subject label as shown in the image below.  

 

A dialog box will load as shown in the image below. This will allow you to edit the Subject for your 
mail shot.  

Please Note: It is possible to add 
multiple Subjects to a single mail 
shot. When doing this a random 
Subject will be used per recipient 
when the mail shot is sent. Using 
this functionality can improve 
deliverability, especially if you mail 
to large numbers of Hotmail, Live, 
Yahoo, Gmail or similar addresses.  

To edit the Subjects select between 
Single and Multiple and enter the 

subject lines as required. 

Once the mailshot has been sent 
you can see how many emails were 
sent and opened by each subject 
line. See mailshot reporting for more 
details. 
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 Attachments 

When you are designing a mailshot, before it is sent, you have the option of attaching documents from 
the Media Library. See Media Library section for further details. Attached documents will be sent as 
attachment when the mailshot is previewed and/or sent. 

Adding Attachments 

To add an attachment to a pre-sent mailshot, please follow the instructions below. 

1. Open the mailshot 
2. Click the Design tab 
3. Click the Add link next to the Attachments field 
4. A new window will open entitled Add Attachment 
5. Either select a Document from the list by clicking on the name (or Upload a new one)  

 

Removing Attachments 

To remove an attachment, click the delete/cross icon next to the attachment name. 

Linking to Documents (An Alternative to using Attachments) 
Adding attachments to your mailshot increases the overall size of the email being sent and could 
potentially cause it to be blocked or the attachment removed. An alternative to attaching a document 
is to include a click-thru link to it within the body of the email. For more information see Adding Links. 

  
 Plain Text Version 

Advanced users may wish to take advantage of the ability to edit the Plain Text version of the email. 
By default an automatic Plain Text version of your mail shot will be created and sent as part of the 
mail email to aid those recipients who choose not to view rich-content emails.  

If you wish to provide your own version of the Plain Text part of the email follow the instructions 
below.  

1. Click the Design tab under the mail 
shot screen 

2. Click the Plain Text tab 
3. Click the Custom Plain Text button 
4. Enter your text in the box provided 
5. Click Save 
6. Ensure you save any design changes 

 



 TUTORIAL:     Gold-Vision Connect 3.6 
 

page 24 of 49 

 Recipients 

When recipients are uploaded to Gold-Vision Connect a further validity check is run.  

To view Invalid Recipients select Invalid Only and click search. 

 

The above shows examples of invalid email addresses 

 

 
 Previewing a Mailshot 

One of the most important factors of sending a mailshot through Gold-Vision Connect is being able to 
preview emails before they are sent. This allows you to check that the design appears as you 
expected and that any personalised template tags are replaced correctly. 

It is extremely important to send preview test emails before actually sending the mailshot. This will 
allow you to review how the email is delivered, rendered and displayed in your inbox. If there are any 
issues then they can be resolved using the designer before sending the mailshot to the final 
recipients. 

 

1. From the mail shot screen click the Preview tab 
2. Enter the email address you would like to send the test to 
3. Click the Send button 
4. After a brief pause a message will display confirming the preview has been queued. 

Alternatively you can preview in a browser window: 

Please Note: Previews are normally delivered instantly; however, they can take several minutes 
depending on your mail server.  

If you need to make any changes, click the design tab, make the changes, click save and send 
another preview. When you are happy with the mailshot, you are ready to send it.  
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 Mailshot Spam Score 

Gold-Vision Connect runs a copy of SpamAssasin that allows you to check your mail shot for SPAM 
score before sending. To run a spam check follow the instructions below. 

1. Ensure you have saved your current design 
2. Under the mail shot screen click the Spam tab 
3. Click the Run Spam Check button 
4. After a few seconds the score and details will appear below 

 
 

 Sending a Mailshot 

Once you are happy with the design, content and layout of your email and have sent a preview you 
are probably ready to send it. It is important to double-check every aspect of the mailshot before 
sending as the send process cannot be stopped once started To begin the sending process, open 
your mailshot and click the Send tab. This will navigate you to a page where you can choose various 
settings and ultimately send the mailshot. 

Pre-Send Options 

Under the Send tab there are several options, these are outlined below 

Confirmation Checkboxes - There are three confirmation checkboxes on the final send screen. 
These must all be checked to be able to send the mailshot. Please only check the options if you agree 
with statements next to them.  

 Link to Images - When images are linked an online reference to the image will be included in 
the body of your email. This will make the email smaller in size and should also improve 
deliverability. When using this option recipients may be prompted to 'show images' when they 
read your email. 

 Include Beacon - A beacon is a small hidden image within the mailshot body that will allow 
Gold-Vision Connect to track and report on the number of recipients who have opened or read 
your email. The inclusion of the beacon is optional because some anti-spam software will look 
for these; hence including one may up your spam index. 

 Standard Encoding or UTF8 Encoding - This setting controls whether the email will be sent 
using either basic ASCII (standard) encoding or alternatively in UTF8/Unicode.  
Standard Encoding. Choose this option if you are sending an email in English or most Latin-
stem languages. 
Utf8 Encoding. Choose this option if you are sending an email in any language that is not 
Latin-stem or contains non-English language characters. 

 Send Now or Schedule - You have the option of sending the mail shot immediately or 
alternatively sending it later on a schedule. 

 Forward Replies Address - If you have chosen to forward replies under 'settings' this will 
show the default address, this can be changed for individual mailshots if necessary. 
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When you are happy with your options continue with the sending process, please see below. 

 

Sending the Mailshot  

To continue the sending process, click the Send button at the bottom. This will prompt you to confirm 
before finally processing the send request. 
Once the mailshot has been "sent", you will gain access to the Tracking, Reporting, Bounce and 
Export tabs. These will allow you to track the progress and responses to your mailshot. Please note 
that if you chose to "schedule" the mailshot you must wait until it has sent before gaining access to the 
reporting tabs. 

Please note only the owner of the mailshot and a Gold-Vision Connect Administrator can send a 
mailshot. 

 
 Tracking  

To open the Tracking section click the Tracking tab. A list of valid recipients can be viewed by 
selecting the relevant tab and click search 

 All – A full list of all the recipients for this mailshot. 

 Delivered - The email for this recipient has been delivered to the recipient's mail server 
successfully 

 Bounce - Sending failed or the email bounced back. 

 Opened - If a "beacon" was included when the email was sent and/or the recipient opened 
the email and all images or clicked through or replied. 

 Click-thru - The recipient clicked on one or more trackable links from the mailshot body. To 
find out which links, click the Reporting tab 

 Unsubscribed - The recipient chose to fully "unsubscribe" from all future email 
correspondence from you. 

 Replied - The recipient replied to your email.  

 Forwarded - The recipient forwarded your email using the built-in forward link. 

 Info - Clicking on this icon will display detailed information regarding the recipient. 

To view and download more advanced tracking data please see the Export section. 

http://help.gv-c.com/MailshotSend.htm
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 Reporting 

To open the Reporting section click the Reporting tab. The reporting page shows graphical 
information regarding the tracking data as well as detailed information regarding click-thrus and read 
dates and times.  
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Subject Line Analysis 

Compares the delivery and open rate for each subject line. 
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 Forward Links   

What Happens to Forward this email clicks? 
Record of clicks for forward this email (custom link in the mailshot) are included in the reporting area 
in Gold-Vision Connect 
 

 

Clicking the link will provide the details of the mail recipient who has forwarded the email.  

Connect cannot pick up email addresses of those forwarded to as this would be contrary to data 
protection best practice guidelines as it would be picking up email details of someone who has not 
positively opted in to your mail campaigns. 

If someone who has been forwarded to then emails the Connect from address this email will be lost 
as they are not a valid recipient of the mail campaign.  This is to protect against spam and to follow 
best practice guidelines. 

 
 Unsubscribers 

What Happens to Unsubscribers? 

Recipients that have "fully" unsubscribed through Gold-Vision Connect will be synchronised back into 
Gold-Vision as part of the above process. The following changes are made automatically in Gold-
Vision against the Contact.  

 The Email Contact Preference will be un-checked. This will mean they will be an invalid 
recipient in email Campaigns  

 A new Note will be added against the contact describing that they have chosen to 
unsubscribe via Gold-Vision Connect  

See Contact section for more info on Unsubscribed Contacts 

 
 Replies 

Mail shot Replies allows the viewing of emails that have been sent in response to the mail shot. 

Viewing and Deleting Mail Shot Replies  

To view a list of Replies for the Mailshot, click the Replies tab. 

 

 

 

To view a mail shot Reply, simply click on the underlined Subject of the e-mail. If you are happy to allow 
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the e-mail to open, then click on I Agree to accept the risk of opening a potentially unsafe e-mail, and it 
will open in a new window. 

 

To forward the email click Forward to and enter an email address 

To delete the  mail shot reply, click the delete icon:  

Please Note: Gold-Vision Connect does not store replies to mail shots indefinitely. Any mail 
shot Reply more than three months old will be permanently deleted. 

To be classed as a Reply the recipient will have clicked Reply and the body of the original 
mailshot will therefore be included as part of the Reply 

If an email has been sent to the Connect email address e.g. info@esteiro.gv-c.com these emails 
can be viewed in the replies section – Mailshots – Replies. For more information see below 

 
 Bounces 
 

 
You can review the reason for messages bouncing by clicking the Bounce tab.Select either Bounce 
Category or Server Response.  

 
 

 
 

 

  

mailto:info@esteiro.gv-c.com
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 Exporting data 

Download/Export Data 

If you would like to export your Connect data into CSV format then click the Export tab from a sent mail 
shot. Please note that you will only be able to do this after the mail shot has completed sending.  

 
Tracking Data 
 

 
 
Bounces 

 
 
Click-Thru Data 
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 Viewing Mailshots 

To view a list of mailshots click the Mail shots menu and the All Mail shots from the sub menu that 
appears. If you prefer to just see your own mail shots then select My Mail Shots instead.  

 

 

Searching Mail Shots  

Mail shots can be searched and filtered by using the standard search control at the top of the screen. 
Please note there are numerous additional search options available under the More Options button.  

The Recipients, Open and Click-Thru sliders help you search for large, small or particularly 
effective mail shots. The date range and status filters allow you to search for a mailshot that was 
uploaded previously and/or is in a particular state.  

 

Opening a Mail Shot   

To open a mail shot item simply click on the name link that appears at the top of the mail shot list 
box. The image below shows where to click.  

 

Please Note: You cannot open mail shots that are currently uploading.  



 TUTORIAL:     Gold-Vision Connect 3.6 
 

page 33 of 49 

Folder Organisation 

Folders can be created in mailshots and templates to enable you to organise them. Click Move then 
select a folder to move the mailshot to. 

 

New uploads will be automatically saved in the correct folder, matching the Campaign Type from 
Gold-Vision. 

Archive Mailshots 

Sent Mailshots can be archived. Archived mailshots are hidden from the default list view, however 
they can be included in the search if required. 

 

Click de-archive to return the mailshot from the archive 

 

 

 
 Viewing All Replies 

Replies can be viewed globally form the Replies tab in the Mailshot section: 
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From the Reply list screen you can: 

1) Open each reply 

2) Click through to the related Mailshot 

3) Forward the email reply to another email such as one of your colleagues who you 

may wish to make contact to the recipient quickly. 

Replies can also be viewed in the same way for each individual Mail Shot from the Replies tab: 
 
See Administration Settings – Mailshots for more information about forwarding replies. 
 

 
 Viewing All Bounces 

 
Bounces can be viewed globally from the Bounces tab in the Mailshot section: 
 

 
 
Bounces can be view by Bounce Category or by Server Response 
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 Reporting 
 

 

 
 
Reports can be generated across all your Connect data.  
 

 
 
Charts can be filtered and downloaded as images to be added to your reports and printed. 
 

 

 
 
User Agent Profile – this report shows you which Browser/device your recipients are viewing their 
mailshots in. 
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 Synchronising with Gold-Vision 

Synchronising with Gold-Vision 

One of Gold-Vision Connect's most powerful features is the automatic synchronisation of data back 
into Gold-Vision. For mailshots this is done in the form of tracking (read, click, bounce...) data back 
into the Gold-Vision Campaign Run itself. 
You will be able to monitor the data from within the Campaign Runs screen from within a Campaign.  

 
 Viewing Campaign Records within Gold-Vision 

The primary location for viewing Gold-Vision Connect Mailshot data 
in Gold-Vision is under the Campaign Run  

1. Open Gold-Vision 
2. Click View > Campaigns or click the Campaigns icon 
3. A list of Campaigns will be displayed 
4. Click a Campaign that you have sent via Gold-Vision 

Connect 
5. The Campaign will open in a new window 
6. From the lower Details/Blue-bar Item menu select Runs 
7. Click on a Run that was sent to Gold-Vision Connect 
8. The Recipients list will open in a new window 

The tracking data will appear next to the recipients in this list 

 

 

 
 
Click on the Gold-Vision Connect Run. This will show the recipients and their click-thru information 

 
 
Using the lists options the list can be filtered down and another campaign run by clicking the campaign 
icon. 
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Viewing Click-Thru Data 
Click the link – Click here to view Click-Thru data 
 

 

This will show you all the Click-Thru data from Gold-Vision Connect.  
 
Use the list options to filter down and create a follow up Campaign as above. 
 

 
 
For example you may wish to filter the list down by a specific link, in this example to the Training 
Schedule page on a website: 
 

 
 
Click Campaign to create a follow up Campaign based on filtered click-thru data. 
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 Viewing Connect Data in Gold-Vision 

 
Select the Account or Contact  in Gold-Vision 
 
Click on the details menu and select Campaigns 
 
Select Campaigns to see the all Campaigns which 
this Account has been included in  
 
Select Click-Thrus to see all Action links which have 
been clicked in a Connect Mailshot 

 

 
 
Using the lists options the list can be filtered and items can be selected  

Viewing Click-Thru data from a Contact record 

 

 
 

Using the lists options the list can be filtered and items can be selected 
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Viewing Connect Preferences 

 

In this example the recipient has selected to 
recieve Newsletters and Event Lists but not Press 
Releases. 
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 Contacts 

 

A list of all contacts uploaded to Connect can be found under the Contacts menu. 

1. Click the Contacts from the main menu 
2. Click the Contacts sub-menu item 
3. A list of your Contacts will load 

You can use the standard search facility at the top of the screen to filter the list of Contacts. As well as 
name, email and other details you can also filter by the contact status.  

 All - Will display all contacts that match your other filters 

 Double Opt-In - Will only display contacts who have double-opted-in 

 Unsubscribed - Will only display contact who have fully unsubscribed from your mailings 

 Blocked – This will show all contacts where the email has bounced 3 times on 3 separate 
mailshots 

 

Favorite lists can also be saved for easy reference, for example you could have a favourite list that 
has been filtered by email address such as “Hotmail” or a favorite list filtered by an Account name.  

Viewing and Managing Preferences  

As part of your mail shot design you are able to allow your recipient contacts to update their details and 
preferences. To view the screen that a particular contact will see when managing their preferences 
click the cog icon that is highlighted in the image below.  

 

 

Reviewing and Unblocking Blocked Contacts 
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 Unsubscribed contacts 

From the list of all Contacts it is possible to filter by status of Unsubscribed. 
Contacts who have unsubscribed are those who have actively requested not to receive your mailings 
in future.  
A contact can unsubscribe by clicking one of the links at the bottom of any of your mail shots from 
Gold-Vision Connect. Once a contact has unsubscribed you are unable to contact them via email 
through Gold-Vision Connect until such time that they choose to re-subscribe.  

 

Which Mail Shot?  
To find out which mail shot a particular contact unsubscribed from, click on the alert icon that is 
depicted in the image below. 

 

Re-subscribe 

 Click on the Edit Preferences icon to re-subscribe recipients to your 
mailings 

 
 Double Opt-In contacts 

From the list of all Contacts it is possible to filer by status of Double-Opt-In. 
Contacts who have double-opted-in are those who have actively clicked on a Double-Opt-in link from 
one of your mail shots. You may chose to only email contacts who have opted in using this preference 
to satisfy and internal or external compliance request.  
To learn more about adding double-opt-in links please see the mail shot custom links page. 
 
 Please Note: The use of the double-opt-in functionality is entirely optional.  

 

Click the icon to view the reason the contact is blocked. Removing the Bounce Flag will allow Connect 
to attempt to send an email to this recipient in a future mailshot. 
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 User Settings 

 

My Details 
View and edit your user details 

 

To edit your details change the required fields and click Save. The Username and Last Login fields 
cannot be changed by the user. 

Password 
To change your password enter the required information and click Update: 

 

Credits 

This shows your remaining credits. 1 credit = 1 mailshot 

 

If you have a query regarding your remaining credits, please contact your Gold-Vision Connect system 
administrator. 
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 Administrator Settings 

Please note: only Gold-Vision Connect Administrators have access to these settings 

 

Users 

This shows a list of Users on your Gold-Vision Connect. To view or edit a user's details simply click on 
their name. 

 

Passwords – Edit your password as per User settings 

Credits – View the remaining credits and the latest credit transaction history. This data can also be 
downloaded to CSV. 

 

Mailshots 

Replies to your Mailshots and emails sent to your Connect domain can be forwarded to a nominated 
email address as per the settings below. This is set up as the Default Reply Address. 
 

 

From the Settings> Mailshots area you can: 

1) Decide the level of Replies you wish to receive: Never/ Always/ Known Contacts Only (valid Connect 
recipients). 
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2) Decide whether or not to have the Out of Office Replies forwarded. By default they are forwarded.  
 
3) If you opt to receive Connect Mailshot replies you can set the Default Reply Address that you wish 
replies to be forwarded to.  Please note that this does not need to be the same as the ‘from address’ 
that the recipient can see. This can also be changed for each individual mailshot. 
 
Please note: your replies will always appear under the Replies section under Mail Shots regardless of 

whether they are forwarded.  
 
 

 

 

 
 
 
From the Reply list screen you can: 

1) Open each reply 

2) Click through to the related Mailshot 

3) Forward the email reply to another email such as one of your colleagues who you may 

wish to make contact to the recipient quickly. 

 

Replies can also be viewed in the same way for each individual Mail Shot from the Replies tab – see 
Mail Shots section. 

 

 

 Contact preferences 

This area allows you to provide advanced selection on mail recipient preferences. 
 

 
 
The Campaign types which are set up in your Gold-Vision system will be synchronised into your 
Connect Campaign Types area: 
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A Connect Administrator can then opt to Show or Hide which campaign preferences are available 
when the Contact Preference Custom Link has been added to your Mail Shot design. 
 
Connect Mail shot recipients can then edit their preferences as they wish: 
 

 
 
This information is then stored within the Connect database and can be viewed from the Contacts list 
by clicking on the Edit preferences icon: 

  

Individual preferences updated in Connect will then automatically synchronise into your Gold-Vision 
system to ensure that future Marketing Campaigns respect selected preferences.   
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 Contact Update 

 

 

You can choose whether you want to allow contacts to update their own details, or simply view them 
so that they can inform you of changes by a different method.   
 
Connect Administrators can choose which fields to make available for recipients to update when the 
Contact Update Custom Link has been added to your Mail Shot design. 

 
 
Connect Mail shot recipients can then update their contact details as they wish: 

 
There is also the ability for Contacts to add a Note to their contact record as well.   
 

 
 
This will automatically create a corresponding Gold-Vision Note against the relevant Contact record. 
 

If a Contact has updated their details, then a Gold-Vision Alert type is available which is triggered by 
changes from the Connect source.  Alerts may, for example, create a note or an activity or send e-
mails. See Creating Alerts in Gold-Vision for more details. 
 
 



 TUTORIAL:     Gold-Vision Connect 3.6 
 

page 47 of 49 

 

 Contact Details Update - Gold-Vision Alert 

If a Contact has updated their details, (via the Contact update link in a Connect mailshot) then a Gold-
Vision Alert type is available which is triggered by changes from the Connect source. Alerts can be, for 
example, create a Gold-Vision alert or send an e-mail to the Account Manager. 
 

Configuring a Gold-Vision Alert 
 
In the Gold-Vision Administration Console select 
Alerting  Configure Alerting  New 

  
 

 
 

 Select On-Save Alert 
 

 
 

 Select Contact type 
 
 
 

 

 
 

 Add Alert text and notes 
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 Click Add Condition  

 Select When the update is from a 
specific source 
 

 

 

 

 Select 
updatesource_datatransferservice 
from the drop down list 

 

 

 Select Add Action select action from 
the list e.g. Raise an Alert in Gold-
Vision 

 
 
 

 
The above example will procude a Gold-Vision 
Alert when a Connect recipient updates the 
Update Contact Details form. 

  

 Select the user from the drop down 

 

 Save the Alert 

 Activate the Alert 
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Creating an Email alert 

 Alerting  Email Templates  New 
 

 

 

 

Enter the following: 

 Enter Description 

 Gold-Vision Object – select Contact 

 Enter Message Subject 

 Type message body, adding fields, select from the list  ‘Add item data field’ 

 To add a link to the Contact record in Gold-Vision clcik the Insert Link  

 Click Save 
 

 

Follow Configuring a Gold-Vision Alert as above 

 Select Send an Alert via Email from the Add Action list and select the Email recipient and the 
Email template 

Save and Activate as above. 

 


